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For your convenience, we have included a quick-reference glossary in this tutorial. It contains 

a list of important concepts for SemTalk 2. As you read this tutorial, you will find terms (in red 

color and italics). Place the cursor on such a term and while pressing the Ctrl-Key click on it 

with your mouse and you will jump directly to the quick-reference glossary. 

SemTalk 2 minimum requirements: 

• Microsoft Visio® 2003 

• Microsoft .NET Framework Version 1.1 Redistributable Package 
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1 WHAT IS SEMTALK 2? 

SemTalk 2 is a user-friendly editor for Semantic Web ontologies and processes. Because 

Microsoft Visio® is embedded in SemTalk 2 it combines the graphical strength of Microsoft 

Visio® and the consistency of a professional modeling tool.  

New modeling methodologies for virtually any modeling problem are easily defined using 

SemTalk 2. Applying a graphically configurable meta model, Microsoft Visio® can be adapted 

to different modeling worlds such as CASE Tools, organizational models and object models. 

The main purpose of this tutorial is to learn how to use SemTalk 2.  This tutorial does not 

include specific methodologies nor Semantic Web or BPM use cases. It is assumed that the 

reader is familiar with the basic Microsoft Visio® functionalities.  

The modeling of processes using specific business process modeling methods (e.g. CSA, 

EPC, BPMN, Promet and others) is covered in additional tutorials. You can find these 

tutorials at our homepage www.semtalk.com/manuals. 

1.1 WHAT IS AN ONTOLOGY? 

For the purposes of this tutorial an ontology is a formal explicit description of concepts (i.e. 

classes) in a domain of discourse, properties of each concept describing various features 

and attributes, and restrictions on properties and attributes (i.e. relation and data types). In 

simple words, an ontology is a formal model for a specific domain of knowledge. An ontology 

together with a set of individual instances of classes constitutes a knowledge base. 

Ontologies are developed to provide a machine-understandable semantics of information 

sources that can be communicated between different agents (software and humans). Some 

reasons to develop ontologies are: 

� to share common understanding of the structure of information among people or 

software agents. 

� to enable reuse of domain knowledge. 

� to make domain assumptions explicit. 

� to separate domain knowledge from the operational knowledge. 

� to analyze domain knowledge. 
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Web Ontology Language (OWL) is a W3C recommendation for the representation of 

ontologies. In case you want to work with OWL, you should use the OWL Template: File-

>New and select OWL.vst in the SemTalk program directory. In this tutorial we will use 

the SemTalk default notation, which is a subset of OWL. OWL Export / Import is 

explained at 24.4 

 

2 GETTING STARTED 

Start SemTalk 2 with it’s icon on the desktop or select Start ���� Programs ���� SemTalk ���� 

SemTalk 2 and begin to work.  

After doing this, the following screen will appear: 

 

 

In this tutorial, we will develop a simple ontology about the banking sector.  

You may also start SemTalk embedded into Visio. In order to do that you must have installed 

the SemTalk Visio Add-In. Start Visio 2003 and open a SemTalk Template (semtalk.VST or 

OWL.vst): 

The explorer contains diagrams, objects, 
relationships and data types. 

The drawing window 

Initially a SemTalk document stencil will 
contain predefined symbols for class and 
instance modeling. 
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You will find SemTalk now embedded into the Visio Menu. Using SemTalk from Visio 2003 is 

recommended, if you need the collaboration functions of Microsoft Office 2003, especially 

Sharepoint Team Services integration. Please be aware that some functionality such as 

“Searching”, “Save as Html” is available from Visio and from SemTalk. The SemTalk variant 

is obviously preferred. In this tutorial we will use the SemTalk program version. 
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3 INSTANCE DIAGRAM 

With the instance editor you will create diagrams for concrete objects having a specific 

identity. Instance diagrams are used in SemTalk solutions for business processes, org. 

charts, data warehouse cubes, product models etc. Virtually any Visio drawing containing 

real world objects such as buildings or a subway map would be an instance diagram.  

Diagrams which are not instance diagrams are called class diagrams. Class Diagrams 

contain abstract objects like data types and classes. In the Visio world classes correspond to 

masters and instances to the shapes in the drawing. Class diagrams are explained in chapter 

4. 

 

3.1 CREATING AN INSTANCE 

To create an instance just drag and drop an “Instance” symbol from a stencil in the drawing 

area. Please open a Visio® stencil e.g. File � Open Stencils. In the embedded Version use 

File->Shapes to open a stencil. 

 

Now, please choose the stencil “Work Flow Diagram Shapes”.  



��������	��
��
����

� ��������	

��
����
�������� � �5 

 
 

Now, you can drag & drop your shape of preference in the drawing area. In this case, please 

use the shape titled “Bank”. Repeat this procedure once more. You can use the shape 

search function on top of the stencil window. In this way you can look for special shapes in 

the installed Visio® stencils. Please find a “Treasurer” shape now. Once you find it, drag & 

drop the shape in the drawing area twice. 

SemTalk 2 assigns automatically an individual name to each object according to the name 

they have in the Visio® stencil. For example, “Bank.19” and “Bank.20 are different objects of 

the class “Bank”. To change the object’s name or other property make double-click on the 

shape or click the right button of your mouse and select “Edit”.  
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Once you have opened the dialog box (like above) change the name of each figure to “Acme 

Bank” & “IOU Bank” for the Bank and “John Doe” & “Mary Smith” for the “Treasurer “ 

respectively.  

3.2 DUPLICATING AN INSTANCE 

If you try to include, for example, the instance “Bank” one or more times in your model 

(ontology) using drag & drop from the stencil and you use the same class and namespace, 

you will get an error message.  
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When duplicating an object with SemTalk 2, it is necessary to maintain its consistency. For 

example, if the user modifies the name of an object, the modification must also occur in 

every duplicate of that object. The “Insert” command has been included for this purpose.  

Please, insert a second “Acme Bank” by right clicking on the drawing area.  

From this context menu please select “Insert” and you will see the 

following dialog box. Check “Existing”, choose „Acme Bank“ and press 

OK.  
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Now, every modification done on the object “Acme Bank” will be replicated in every of its 

instances.  

3.3 REMOVING OR DELETING AN INSTANCE 

At this moment, it is convenient to point out that with “Del-key”, “Ctrl-X” or  “Object � Delete 

from Drawing” you are only erasing the chosen shape from the drawing area, but not 

removing it from SemTalk 2’s objectbase. In case you want to 

remove an object from the drawing area AND from the objectbase, 

you must use “Remove” from the context menu or “Object � Delete 

from Model”.  

Please select the last “Acme Bank” in your drawing area and right-

click on the shape.  

In this way, the object “Acme Bank” will be removed from the 

objectbase and from the active page, as well as, from every other 

page of your SemTalk 2 file. In SemTalk 2 there is no Undo command 

that will not restore the removed object and its properties.  If you delete an object, you may 

restore it in your diagram(s) by inserting it, like shown before. 
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SemTalk 2 model-based functions like Browse, Find and Expand will be described later in 

this tutorial. 

4 CLASS DIAGRAM 

So far you have create instances of classes. The meaning of the Visio® shapes you 

previously used is defined in class diagrams. In our example, we used Visio® shapes related 

to banks and treasurers and we gave them individual names. In a class diagram we could 

now extend the definition of our model by defining that a treasurer works at a bank. This 

declaration is valid for the instances we modeled before. Furthermore, in the class diagram 

you can define attributes that are inherited by subclasses of your class. For example, the 

subclass “Home Loan Bank” will inherit attributes and relationships (e.g. employs - inverse 

relationship of “works at” - and number of branches) from the class “Bank”. Abstract classes, 

e.g. “financial institution”, have no Visio®-shape (yet) and therefore, you can use the general 

class symbol.  

        

4.1 CREATING A CLASS DIAGRAM 

Each SemTalk 2 page has a type, i.e. an instance type or a class type. Thus, the first step is 

to define the page as a class diagram. To do this, insert a new page by: 

� Diagram � New � Generic (in this case) or 

� right-click on top of the page-tab and select “Insert Page” and name the new page “My 

classes”  

Now right-click on the diagram area and choose “Edit”. You should now see the following 

dialog box. 
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Please change now the diagram type to “Class”.  

 

 

 

4.2 CREATING A NEW CLASS 

At this moment, you are ready to begin defining classes. If you drag & drop the shape “Bank” 

in the drawing area you will define general properties of the class “Bank”. Remember that 

everything you define for a class is valid for its instances. 

Inserting a new class using no predefined 

Visio® Master Shape is very easy. Please 

drag the class symbol from the “Class” stencil 

window         and drop it on the drawing area. 

Give the class a name, e.g. “Financial 

institution”, a press OK. 

 

Now your diagram “My classes” should look like this: 
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To edit a class and its properties, 

� double-click on the object or  

� press the right button of your mouse and choose “Edit” from the context menu or 

� from the menu select “Object � Edit”  or 

� find the object in the explorer as a child of “Diagrams � Generic � My classes 

(context menu) 

� find the object in the explorer as a child of “Objects” (context menu) 

You should now see the following dialog box: 
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4.2.1 General 

Name is the name of the object. You may change this name to specify the class name. 

Namespace is the namespace of the class name for the object. The identifier of an object is 

the combination of a namespace and the name. E.g. “Tr#Treasurer” is the object named 

“Treasurer” in the namespace “Tr”. There might be another object “Hu#Treasurer” which is 

also displayed as “Treasurer”. Each name can be used in a namespace only once. You can 

clearly define an object companywide or even worldwide by combining of the name of an 

object and an URN, e.g. like this: "http://www.SemTalk 2.com/banking#Bank". Each name 

can be used in a namespace only once. 

Comment is the description or definition of the class. 

Language allows to specify comments in a chosen language. Objects may have multiple 

names in different languages and multiple comments. 
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Links, e.g. hyperlinks can be added or deleted using the context menu (right-click) of the 

Links text field or the “+” or “-“button respectively. 

Read Only marks the class as read only and protects it e.g. from renaming or deletion. 

4.2.2 Attributes 

The attributes of a class can be defined and edited on the “Attributes tab”. Some Visio-

Shapes have already attributes. You can use them, you can also edit them or just delete 

them. Please create the attribute “Address” by pressing “New”. 

 

Double click or press the “Edit“ button to open the attribute details dialog box. The button 

“Delete” is intended to delete an attribute. “Value” is a convenient way to enter a larger piece 

of text into an attribute value. 

 



��������	��
��
����

� ��������	

��
����
�������� � �14 

 

Type specifies the type of this attribute e.g. Symbol, Boolean, Float or Number. Attributes do 

not require the selection of a type.  

Value is the default value for this attribute. 

Is List allows the use of multiple valued attributes. E.g. “red” and “green”. 

Options specifies the options for values of that attribute E.g. “red” or “green” or “blue”. Those 

options will be used as options for the values combo box. 

After closing the dialog, the value is shown in the right part of the attribute list. 

NOTE: The inheritance of attributes and values will be explained in the course of the next 

section. 

4.2.3 Associations 

Associations are shown and edited on the “Associations“ tab of the class editor. The easiest 

way to define them is to do it graphically.  In order to do this, we will add additional classes to 

this example.  

From the “Work Flow Diagram Shapes” drag & drop the Treasurer shape in your drawing 

area. 
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A class can have subclasses that represent concepts that are more specific than the 

superclass. The “subClassOf” association defines a taxonomic (subclass – superclass) 

hierarchy. Adding relationships is quite simple.  Drag & drop the “subClassOf” shape 

somewhere in the drawing area or by clicking first over the “Connector Tool” and then 

clicking over the “subClassof” shape in the CLASS Stencil. 

 

If you pull the end-point of the arrow over an object’s “connections point” you will notice that 

you can glue the relationship to that object. With the “Connector Tool” you just must click 

over the 2 shapes you want to relate. You can do it more than one time subsequently. A red 

coloring will tell you if the connection was successfully done. Select an end-point and glue 

your new relationship to the objects of your choice. Notice that in case of the “subClassOf” 

relationship the arrow points toward the superclass. 

You can change the class of instances by using the “Class” combo box of this dialog box in 

the “Edit” dialog. 
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NOTE: Use always a singular name as object name. It is not recommended to model “Banks” 

classes, since the class “Bank” already describes one or more banks. 

In our model “Central Bank” became a subclass of “Bank“. It inherited the attributes of 

“Bank”, but you can now add further attributes to “Central Bank“ or change the values of 

inherited attributes using the “Edit” button. In the same way “Bank” is a subclass of “Financial 

institution”.  
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Inherited attributes are characterized by a “�”. If you change the value of inherited attributes 

the SemTalk 2 object engine creates a local copy of the attribute. It will be deleted when you 

delete (reset) its value. 

 

Please look at the model explorer.  

Under Diagrams the contents of 

“FirstPage“ are listed as children of 

“Objects”.  This is a graphical view of 

how classes are defined and it shows 

their inheritance tree structure. 

Please create a new association using 

the “Property“ shape.     Define a 

new association between Bank and 

Treasurer. 
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As the Property name you may type “works at” 

 

If you open the “Edit” dialog box for “Central Bank” and open the “Associations” tab, you will 

notice that the relationship “inv works at” has been inherited from “Bank”. “inv” means that it 

is the inverse relation. If you right-click on a link and choose “Edit” you can edit the properties 

of the association. To edit the relation class “works at” find this class in SemTalk’s Explorer 

under Associations. Edit this class and change “inv works at” to “employs”. 
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NOTE: “Remove” deletes the association from the model. Deleting using Delete from 

Drawing  or the Del-key only removes it from the drawing. Classes and other objects behave 

in a similar manner. 

 

5 SAVING 

Please use Save or Save As. In addition to Visio®’s VSD file, a XML file for the model is 

created.  

6 INSERT 

You can insert existing classes in new diagrams very easily with SemTalk 2. Please create a 

new diagram using Insert � Page option. Rename the diagram e.g. “Diagram2” 

Right-click on the drawing area of the diagram and change the diagram type to class diagram 

(refer to section 4.1). Having done that, please right-click again on the drawing area and 

choose ”Insert“ to insert existing classes into the new diagram. Alternatively you may use the 

menu Diagram � Insert. You will see the following dialog box: 
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Type: You can insert classes, relation types or diagram types into generic class diagrams. 

For other diagram types restrictions may apply. 

Existing: As default the list contains only objects which are not shown on the current page.  

If you check “Existing” you can insert those objects again. 

Metamodel: Include classes which are set to “ReadOnly” (In most cases the element of the 

Metamodel. 

External: Allows objects from an external model to be inserted.  Refer to the next chapter for 

information about linking models. 

Index: Allows objects from an external models found by the SemTalk 2 Indexer to be 

inserted. 

Create Location: You can decide whether to insert an external object as reference or as a 

copy of it. You will find more information about linking models in the next section. 

Insert all valid Relations: All relations, which are in the objectbase, to other objects on the 

diagram are being visualized.  

Master: It specifies the shape to use. “Default” is until now used shape. “UML” uses a UML  

class shape. “Shape” searches for a shape master with the same name as the class. 
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NOTE: You can change the size of the “Insert” dialog box with your mouse. 

Please, choose “Financial institution” and press OK to insert the class. 

7 (HYPER-) LINKING MODELS AND NAMESPACES 

To insert external objects in a SemTalk 2 diagram an external model must be loaded first. 

Loading an external model is very easy. From the menu, select File ���� Show External 

Model. In the Look in list, click the drive, folder, or Internet location that contains the XML 

file you want to open. For the purpose of this tutorial, we created in advance an “Urban 

areas” model to be imported http://www.semtalk.com/pub/urban.xml. You can use File ���� 

Show External Model->URL to reference it. 

Once you have opened the XML file, SemTalk 2’s Explorer should look like this: 

 As you can see, the explorer contains new grey colored 

objects. These objects exist in the “to-be-imported” 

model. Until now, they exist only virtually in the “urban“ 

model. To make them part of your model you have to 

import them. There are 4 ways to do this: 

• Drag & drop the object(s) in your diagram. 

• Menu Object->Import 

• Right-click over the grey colored object in explorer 

• Right-click over the drawing area of the diagram, 

where you want to insert the external objects and 

select “Insert”. Once you see the dialog box click the 

“External” button 

Please insert the classes “Building” and “House” using the way you prefer. Please notice that 

the objects inserted can only use the “Default” or “UML” shapes. 
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There are two ways for inserting objects from external models located in the Internet. You 

may want to insert objects from models that you indexed in advance. Indexing a model is 

quite simple. First select Tools ���� SemTalk Options and then select the “Index” tab.  

 

For the purpose of our example, please be sure to check 

www.semtalk.com/biztalk/biztalk.xml If this URN is not on your list, right-click the list, choose 
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new and enter the address. Press “Rebuild” to make sure that SemTalk has successfully 

indexed this model(s).  

Now you are ready to import indexed objects by right clicking on your drawing area and 

select “Insert”. The procedure is similar to the one describe before in this chapter, but instead 

of pressing the “Extern” button, press the “Index” button to see the list containing all the 

indexed objects. 

8  COMMENTS 

In order to display a comment / definition of an object drag & drop the “Comment” shape in 

the drawing area and point with the “definition of” connector to one or more objects: 

 

By double-clicking on the comment shape the “Edit” dialog of the object will open. 

9 EXPAND 

When models are expanded, diagrams are extended using information, which has already 

been modeled.  For example, if a Bank is associated with Treasurer, we can add related 

objects to the active diagram based on information modeled in other diagrams. 

Right-click “Expand” on the class “Bank” in diagram2. Alternatively, you may use the menu 

Object � Expand. 
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If you select “employs”, the class “Treasurer” will be shown in the diagram. 

In case external objects are to be expanded, you will see an “External” button in the dialog 

box. If you select this button, locally related objects will no longer be seen in the dialog. 

Instead, the related objects of the external origin are visible. If you select such an object, you 

will get a reference to another external object. 

In this way, a kind of Internet of connected reference models can be built. You can find an 

example at http://www.semtalk.com/semnet_files/XGRID_of_Models.htm. 

10 BROWSE 

With the “Browse” command in the context menu (right-click on an object) you can navigate 

to other visualizations of that object. Alternatively, you may use the menu Object � Browse. 

The upper list box shows all diagrams that have a node for the object. The lower list box 

shows all diagrams that have a node with objects having a relationship to the object. 
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In order to navigate to other objects you can double-click on the object or select the desired 

object and press “Browse”. By checking / deselecting the checkboxes “Super”, “Sub”, 

“Relation” and “Instance” you can filter the objects in the lower list box. “Objects with 

compose” is used for Business Process Modeling only. 

11 REMOVE 

The “Remove” command on the context menu (right-click on a node) will delete the object or 

relationship from all diagrams in the model. Alternatively, you may use from the tool bar the 

menu Object �” Delete from Model”. 

NOTE: Objects, which are not displayed on any diagram, can only be deleted from the model 

using the explorer. Select the object in the explorer and use “Delete from Model”. 

12 REFINE / DETACH 

The right-click command “Refine” attaches a diagram to an object. You can also use Object 

� Refine. 

If the object has a refinement, “Refine” will open the corresponding diagram immediately as a 

result of a kind of hyperlink navigation.  
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You can navigate back from the refinement to the refined object using Diagram � GoUp or 

selecting GoUp from the context menu of a diagram (by right-clicking an the drawing area of 

a diagram). 

NOTE: Objects having a refinement are displayed with underlined text. 

“External” assigns a diagram in another SemTalk model. Refining such an object will open 

the related SemTalk document. 

NOTE: The diagrams are attached to the object, not to its visualization. This implies that the 

object is refined on all diagrams. 

The resulting refinement tree is reflected in SemTalk explorer: 

 

The command “Detach” removes the link to the diagram, but not the refined diagram itself. 

A refinement is more than a shortcut for navigation. All objects on the refinement may have a 

specific relationship e.g. “subClassOf” to the refined object. For more details please see the 

following chapter. 

As a diagram 
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13 EDIT A DIAGRAM 

Please select a diagram and right-click the option “Edit”. You may also use SemTalk � 

Diagram � Edit.  

 

 

Name is the name of the diagram. 

Class is the diagram class (or diagram type). Diagrams are also SemTalk objects.  New 

diagram classes may be processes or product models. Details of how to do this can be found 

in a later chapter. 

Type specifies the type of object being displayed in this diagram. There are class diagrams 

and instance diagrams. 
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14 FIND 

Find is located on the context menu of the drawing pane or in the SemTalk menu. Using Find 

you can search objects displayed on your diagram or navigate to them. 

 

Name is the string to match. Blank “Name” matches every object. 

Begins with searches only for objects where the name starts with “Name” 

 “Name” for object names, “Synonym” for alternative names, “Attributes” for attribute names, 

“Values” for attribute values and “Methods” for methods, etc. (Synonym and Methods are 

explained later on). 

The tree diagram shows the matching objects and corresponding type. You may double-click 

an object or use the “Show” to go to the object.  

15 VISIO STENCILS 

You may define classes and instances based on Visio masters from any stencil.  To open a 

Visio Stencil go to File � Open Stencil and you will see the following dialog box. Open a 
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Visio stencil e.g. Enterprise Application and drag a class to a class diagram. SemTalk 

creates for each master a class. You may have to rename the class afterwards to match your 

requirements. 

 

If you drop a master’s class into an instance diagram, SemTalk will create an instance for 

each shape that inherits from the class with the master’s name. 

16 NEW VISIO MASTER 

Until now, you have created class diagrams with existing Visio-Master-Shapes or with 

abstract objects. You have also built instances with Drag & Drop. 

If you want to create new Visio-Master-Shapes you have two possibilities. Either you copy an 

existing Visio-Master-Shape or you create a new one. Important is that the names of the 

template symbol correspond with the class names in the existing models. Therefore, please 

copy the respective Master-Shape and insert it in the “Document stencil”. It is in the 

“Document stencil” where you can rename the symbol (“Master-Shape-Properties” in the 

master’s context menu). Now, you can use the symbols from the “Document stencil” or 

create your own stencil to build your models. 
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For the purpose of this tutorial, we use the Visio-Master-Shape for “Person 2” as “Manager”. 

Please do as follows: 

1. Open the “Document stencil” in the tool bar menu Visio � View � Document stencil. 

2. Open the “Work flow diagram shapes stencil”. (File � Open Stencil � Work flow 

diagram shapes) 

3. Drag & drop the master “Person 2” from the “Work flow diagram shapes stencil” in the 

“Document stencil”. 

Rename the master “Person 2” to “Manager” in the “Document stencil” by right-clicking on 

the symbol and select “Rename Master” from the context menu. 

NOTE: IN SemTalk 2 you can not create or edit graphically a Visio master. Stencils and 

masters can be edited only in Visio.  

Please drag a “Manager” and drop it in your instance diagram. Then, assign the “Manager” a 

name. 

You can also use the generic Instance symbol. Please, drag the “Instance” master from the 

“INST” stencil and drop it in the drawing area. 
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When you create instances with the “Instance” master, you can choose any class you wish. 

Assign the corresponding instance the class “Central Bank”. 

 

The instance “Federal Reserve” refers to the class “Central Bank”. You can make the 

connection to any subclass defined in the class diagram. In other words, you can neither 

represent a Treasurer nor a Manager with the Bank symbol and vice versa.  

With the “New” button you can create directly new classes. Instances have their own 

namespace, their own comments and links. 

Attributes are inherited from the classes, but they can be overridden. 

17 CUSTOMIZE 

Customize specifies how objects will be displayed.  In addition to the object’s name, it is 

possible to show any attribute or association value. 

Layout specification may be overwritten in subclasses or within single instances. Please 

select the Bank class from the explorer and select the menu Object � Customize. In the 

dialog box select the “Instance Layout” tab and the “Title” sub tab.  
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“Instance Layout” specifies how instances of the class (or its subclasses) will be displayed in 

instance diagrams. “Class” Layout specifies how the class itself or its subclasses will be 

displayed in class diagram.  

If you want to use instance layout for a specific class, you MUST check the “Instance 

Layout” checkbox. If you want to use class layout for a specific class, you MUST 

check the “Class Layout” checkbox.  

The left list box shows all currently selected attributes and the right list box shows all possible 

attributes or associations. Right clicking in the list boxes to add and remove selections. 

In case you have complex shapes, you can choose, by right-clicking on the name in which 

subshape the value will be displayed. You can address up to 5 subshapes. Multiple attributes 

can be displayed in the same subshape. Using “Group” you can specify, that you will select 

the shape itself (and not a subshape). 

 

“Tabs” are used to customize the appearance of the object edit dialog. 
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Here you can select which tabs to show in the object editor. The check boxes on the left side 

enable or disable SemTalk’s system-defined tabs. If you were using a specific modeling 

method (e.g. a specific process modeling method) you would see a list of check boxes with 

the name of the method-defined tabs for that method. 

NOTE: In the screenshot you can see the other SemTalk tabs - Methods, States and 

Language. In particular, the language tab is quite useful for specifying alternative names for 

the object.  The SemTalk “Find-Dialog” also searches for label in different language 

(“synonyms”).  

Instances exist on exactly one Diagram Instances will be deleted from the 

objectbase as soon as they are deleted from 

the diagram.  

Anonymous Instances Behavior often used for activities in 

processes. You must have a master named 

as the class. If you renamed an instance of 
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the class, a new super class for the instance 

is created. The instance is not individually 

named. It name is super class name + “.” 

+ID 

Refinement of Class Used together with “Anonymous Instances”: 

refinement will be attached to the super 

class and to the instance. E.g. the activity 

“write Book” will be refined by the same 

subprocess in all processes where write 

book is used 

Create Subclass on Drop Similar to “Anonymous Instances” but used 

on classes. Every time a class master or 

class from explorer is dropped onto as class 

diagram, new subclass is created instead of 

inserting the class in the diagram  

Hide in Explorer This class is not shown as a root class in the 

SemTalk Explorer 

Color Shapes showing instances of the class will 

get the specified color overwriting the color 

of the master  

 

18 ASSOCIATIONS ON INSTANCES 

The property connector is used to define associations between instances.  If a connection is 

made to an instance, a dialog box pops up and offers the possible associations specified in 

the class of the instance.  Only for the purpose of our example, a “Treasurer” works only at a 

“Central Bank”, but does not work at a “Bank”. 

You may change the association class of each existing link by right-clicking the connector 

and choosing “Change Relation”. Associations, which are not specified in the class model, 

are not allowed between instances. In this way, SemTalk adds semantics to Visio shapes. 
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In the “Associations” tab of the instance edit dialog, you may edit an association (property). 

Associations are ordinary instances of their association class. You may define associations 

on associations. 

19 ASSOCIATION CLASSES 

Since associations are instances of an association class, they are used to define attributes. 

In our example, we can add an attribute “arrival time” on the class, which can then be edited 

for each instance. 

Please add the association class “works at” to your class diagram, using right click insert on 

the background of the diagram. Select “Relation Type” in the type combo box and then 

“works at” in the list box. 

The class will be displayed in the 

class diagram. You may add now 

attributes, subclasses and new 

associations. 

If you need a specific Visio 

connector for an association class, 

you can drop a Visio Connector to a 

stencil and rename it to the name of 

the relationship you want to use. 

Using the new master shape will 

automatically select the specified 
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relation with the matching name. 

19.1 ASSOCIATION CLASS OPTIONS 

Associations cannot only connect instances with instances, but they can also be used to 

connect instances with classes and vice versa. 

Please create the association class “manages” by associating the classes “Manager” and 

“Bank”.  

 

Select “manages” in the explorer as a direct child node of “Associations“.  Open the dialog 

box using right click “Edit” (context menu).  

NOTE: You may edit any object from the explorer using right-click edit as classes, instances, 

diagrams and diagram classes.  

Using the Association Class Editor, you can specify an instance: A single item of information 

that is representative of a type. 

inverse name for the association and properties as aggregation and transitive. 
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The tab “Details” presents other options to specify which types of object may be associated 

(class or instance) and some of their cardinalities. 

In case of an aggregation, the class own relations and its inherited relations will be shown. 

When working with an aggregation, the relations of a subclass will be added to those from of 

a superclass.  
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Aggregation can be here understood as a “is part of” relationship. With “Tree” you prevent 

cycles. A transitive relation is e.g. “bigger”. When A is bigger than B and B is bigger than C, 

then A is bigger than C. In case of symmetric relations, the inverse name is the same as the 

name. “Multiple” means that between two objects more than one relation of the same kind 

are allowed. “Unique” means that only one relationship of this relation class is allowed to 

exactly one other object. 

20 HTML GENERATOR 

In order to create an HTML version of your model you File->Save As HTML.  

In the following dialog specify the name of the main (start) htm page. You must save your 

diagram before using the HTML generator. 
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Title specifies the name of the Website. In case of working with multilingual models, the next 

field is used to specify the language in which the Website will be saved.  

Stat page determines the file path of the start page to be generated. Do not generate to 

network drives. Always generate to a local directory such as C:\myhtml and transfer the html 

afterwards to the fileserver. 

External Document Base field is used to specify the file directory where the linked 

documents (to the model objects) are located. The path can be absolute or relative to the 

directory where you save the html.  

  

Other options are used to determine which elements and functionalities are to appear on the 

Website to be generated. 

Options Description 

Goto Page Facilitates a fast navigation across the diagrams. 
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Pan Zoom Allows zooming of the diagrams. 

Search Enables the search in the website.  

Property Pages Shows the properties of a selected object in a diagram 

SemTalk Tree Reproduces the same SemTalk explorer in the Website 

WMF, SVG, 

JPG, PDF 

For each page a printable copy in the desired format will be created, to 

simplify printing of individual pages 

Other Browsers Visio is generating HTML for IE 6. HTML for other browsers than IE has 

much less functionality and generates are large number of small html 

pages 

External Start 

Pages 

For each object it generates an own start page, where external models 

can be referenced. 

 

Under “Tree Properties” you can choose which object types are to be displayed. Normally, 

classes and diagrams will be displayed, but you can also choose associations, attributes, 

synonyms or instances. 

The tab “Property Details” contains the options to choose which properties are to be shown 

in the property part. 

Finally, under the tab “Multi-HTML” you can decide which models to connect within your 

Website. In order to do that, the connecting models must be located in the same file directory 

as your current model, as well as, the already generated HTML versions of these models. Do 

not forget to reference previously the objects to the respective models. 

21 REPORT GENERATOR  

In addition to all the multiple possibilities to view your business process, SemTalk offers you 

a comfortable way of generating reports of every model. 

To create new reports open SemTalk Report Editor selecting File � Report � Report Editor. 

You will see the following dialog: 
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With SemTalk Report Editor you can create reports, save and reuse report formats. The tree 

structure shows the logical structure of the query and the attribute which are included. The 

right part shows the result of the query as XML or as a table. 

In the right combo box we can select “Bank”. The option “All Instances” will list direct and 

indirect instances of Bank. We can see now the attributes and related objects in the treeview. 

For the picture have selected Name, Class and the diagram on which the is displayed as well 

as the inverse relation of manages. As output format we have chosen a tabular view. 

The structure of the reports is determined by the objects, attributes and associations in the 

model. The queries can be nested as deep as you need. 

The XML output can be saved as an XML file. The table output is saved as html table, which 

can be opened in a lot of tools including MS Excel. 
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Use the menu option Tools � Options to 

specify additional options for report.  

“Convert Lists to strings” will concatenate 

multiple value to one string and write that 

into a cell instead of creating multiple rows. 

“Include other model” allows to run a multi 

model report. Other models will be virtually 

merged in before the report is being 

executed. Please make sure, that you are 
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using models with a compatible meta model. 

 

 

22 EXTRAS AND TOOLS 

Under the menu option Tools SemTalk, different functionalities have been grouped. With the 

explorer options, you can hide or show SemTalk’s Explorer by selecting “Show Explorer”. 

With “Refresh”, you will actualize the explorer. 

22.1 TABLE EDITOR 

The Table Editor you have at your disposal another way to edit information in your models. 

You will create and use Microsoft Excel tables to visualize and edit information about classes 

and instances in your models. 
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With the “Export” button an Excel table will be created and opened with the attributes you 

selected. You can edit the attribute values in this table and with the button “Import” import the 

information you edited in the Excel table. The Language tab allows the fast translation of 

objects. 

22.2 WIZARD AND WIZARD WINDOW 

SemTalk has a consistency wizard (Merlin), which checks some rules while modelling. 

By right-clicking menu                       and selecting “Show” or “Hide” you activate or 

deactivate the wizard. “Replay” replays the last wizard comment. If the “DoMagic” command 

is available, you can allow the wizard directly to fulfil his proposal. 

NOTE: If you are not able to hear the wizard, you may have to install the speech-engine from 

http://www.microsoft.com/msagent/.  

“MS Agent Character” is the used MS Agent character. 

Other characters are found at 

MSAGENT/CHARS/*.acs or at the MS Agent web 

site. 

When an inconsistency situation occurs (e.g. a class 

already exists in an indexed model) and is detected 

by the Wizard, it will “tell” you about it (in case the 

corresponding speech-engine has been installed) or 

just present it to you as legend.  

The “Wizard Window” records all the messages that 

the wizard has presented you. If you want to see 

these messages, go to Tools � Wizard Window. 

The Wizard configuration will be explained later in this tutorial. 
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22.3 MACROS 

The “Macros” command allows you to run 

small SemTalk complementary 

applications written in a script language. 

The example shows three subroutines 

contained in the file count.vbs. You can 

open a new macro file by clicking “Open”. 

Edit will open a script editor (not part of 

SemTalk). “Execute” will run the selected 

subroutine. 

 

22.4 REPLACE 

The “Replace” command is used to globally replace strings (rename) in different object 

properties. You have the following options: 

Name Global replacement of a string in object 

names 

Location Global replacement of a string in object 

locations (references) 

Path Global replacement of a string in object 

attachments (documents) 

Namespace Global replacement of a string in object 

namespaces 

 

22.5 SEMTALK OPTIONS 

SemTalk 2 configuration options are found under the menu command “SemTalk Options” 

(Tools � SemTalk Options) 
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22.5.1 Namespaces Options 

Under the tab “Namespaces” you can specify the language priority for your models. You may 

specify a neutral language (option “<none>”) to develop a standard version of your model. In 

our example, we have specified “English” as our model language. Language 1-3 use used to 

specify sublanguage. E.g. Language 1 is English and Language 2 is Medical. If there is no 

definition in Language 3, Language 2 is used. If there is no definition in Language 2, 

Language 1 is used.  

 

The “Object Method” and “Method Object” options are to indicate the semantic order of the 

name in which classes and instances of activities are identify. For example, in English an 

activity would be expressed as “Method Object”, but in German it is expressed as “Object 

Method”. 
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Let us add another language. In order to do that, please open now the edit dialog for the 

class “Central Bank”. Under the tab “Language” press “New” 

enter the German term for central bank “Zentralbank” and 

press OK. In the next Synonym dialog please enter German as 

language. 

You should be able to see now on the menu toolbar German as one of the optional 

languages for your model.  

If you are working with multilingual models, it is recommended to choose a neutral language, 

develop the first version of your model, and then change to a different language to specify 

the object synonyms in that other language. 
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If you specify “German” as Language 1, every object that has a synonym in German will 

have a shape label in German, as well as the name in the edit dialog.   

 

22.5.2 Wizard Options 

As mentioned before, SemTalk has a consistency wizard. SemTalk Wizard can be 

configured with the tab “Wizard”.  
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SubClassOf Checks whether the “SubClassOf” connector 

points from the intended subclass and not 

the superclass. This is a very popular 

mistake. 

Checks whether the name of the subclass is 

included in the name of the superclass. 

External models for name The name of the object has been found in 

another indexed model. 

External models for synonym The name of the object has been found as a 

synonym in another indexed model. 

Homonyms There is another object with the same name 

in another namespace. 

Synonyms The name has already been used as a 

synonym. 

Case Sensitive Names The object exists with a slightly different 

spelling. 

Composition The object name consists of words which 

are already used in other objects. 
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Attributes The object name contains a word that has 

been used as an attribute 

Methods The object name contains a word that has 

been used as a method 

States The object name contains a word that has 

been used as a state 

 

22.5.3 Shortcuts 

If you are using references to external models, namespaces (URNs) can get quite long. In 

the “Shortcuts” dialog you can define shortcuts for namespaces which are used in all 

SemTalk dialogs. Shortcuts are assigned for the current user and apply to all objects in the 

current model.  

Using Add/Delete/Edit you can add and assign shortcuts for namespaces used in the current 

model. 

OWL Import will automatically add all those namespaces and shortcuts found in the OWL 

file. 
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22.5.4 Index 

You can index objects from external models. Indexing a model is quite simple. Under the 

“Index” tab check those file paths or URN’s of those models that you wish to index. If this 

URN is not on your list, right-click the list, choose new and enter the address. Press 

“Rebuild” to make sure that SemTalk has successfully indexed this model(s). 

 

22.5.5 Explorer 

Using the explorer options, you can customize the appearance of SemTalk’s Explorer. The 

explorer options are saved with the model (xml-file). 
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Show Namespaces Displays the object  identifier in the treeview: Namespace#Name 

Show Diagrams Show the „Diagrams“ subtree. 

Show Generic Diagrams Show diagrams without a specific user defined type. These 

oftenthe meta models 

Edit Diagram Types Create, edit and delete diagram types 

Show Objects Show the “Objects” subtree. 

Edit Objects Create, edit and delete object from the browser 

Subclass Hierachy Show subclasses as inheritance hierachy. If you do not select 

this option all classes are listed alphabetically. 

Edit Attributes  Edit and delete attributes. 

Edit Relations Edit and delete relation types (association types) 

Associations Show the “Associations” subtree. 

Attributes Show the “Attributes” subtree. 

Methods Show the “Methods” subtree. 

States Show the “States” subtree. 

Datatypes Show the “Datatypes” subtree. 
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22.5.6 Extras 

At the “Extras” Tab you can define the following options: 

Save SemTalk XML File Check this option to create an xml file of the current model 

without graphical information. Useful to reference models. 

Password Enter a password to lock all those objects that have been 

defined as “Read Only”. 

Hours per day Specify how many working hours a day has. Used with 

business process models and simulation. 

Show Background Pages Background pages are usually hidden. Check this option if you 

need to change them. No SemTalk objects can reside on 

background pages 

Always use ‘Compose’ Indendent for process modeling. Applies Object->Compose to 

every new activity 

Show all Language tabs Language tab is always visible in Edit dialogs without 

customizing each individual class 

No BottomUp Methods Indendent for process modeling. At Object->Compose new 

verbs can be entered that are not defined in a class model 

Startup Logo Change the Splashscreen 
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23 HELP 

The Help command provides the user useful functionalities.  

Index Opens a short menu reference in HTML format. 

Check and Repair Checks the consistency of a model and repairs any detected 

inconsistency. Using this function has the risk of deleting corrupt 

information and objects, which have inconsistency problems. 

Upgrade Rebuilds menus after the import of SemTalk 1 models 

Registration Register your SemTalk license (SemTalk Key) here. 

About SemTalk Version and license info 

 

24 EXPORT / IMPORT OPTIONS 

The ability of the “Export / Import” options depend on the modeling method and the template 

been used.  
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24.1 SEMTALK IMPORT 

In order to merge SemTalk models use File����Export/Import����Import. Using import 
complete or partial models can be merged. Select an existing model and the following import 
window will appear: 

  

 
 

On the left hand side there is a treeview similar to the SemTalk Explorer where you can 
select objects by diagram or by hierarchy. Additional objects may be imported. On the right 
side there is a Visio control for previewing the page to be imported (Note: preview is not 
available for the Visio embedded version, Note 2: Do not try to change anything in the 
preview. You can not save it anyway) 

Please check those objects or diagrams you want to import and afterwards use File->Import. 

An Import Options dialog is popping up which allows to specify some parameters for the 
import. 
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Create References / Locations Each object will get a reference to the 
imported file so that it can be updated using 
Object->Refresh afterwards 

Change Diagram class Use this option to import method specific 
ontologies / Class models 

Replace Namespace Replace the namespace of imported classes 

 

SemTalk Import is an option if you want to import complete diagrams or a large set of 

objects. If you need single objects “Show External Model” with Drag&Drop (Chapter 7) is 

more convenient. 

24.2 SEMANTIC WEB 

Semantic Web is a new Internet made of data. Models made for the Semantic Web are 

called ontologies. W3C came up with some recommendations to store information in the 

Semantic Web: RDF (~Instances), RDFS (~some aspects of classes as you have seen in 

SemTalk so far), OWL (http://www.w3.org/TR/owl-features/, complete description logic). 

In SemTalk we are using Semantic Web data structures to exchange data in a vendor 

independent way. Any SemTalk model can be exported completely to OWL. Most OWL 

ontologies can be imported to SemTalk and used as class models for various purposes.   

If you want to use SemTalk as an OWL editor, you should use the OWL template OWL.vst 

which was developed in conjunction with www.cerebra.com and has all the additional 

constructs which are needed to cover the complete set of OWL feature. If you need to exploit 

these features we recommend to use SemTalk in conjunction with reasoners such as 

www.cerebra.com, www.ontoprise.com, FACT or RACER.  

To order to import OWL, RDFS, RDF data use  File� Export/Import � Semantic Web.  
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Abb. 1: OWL Import Dialog 

As an import file you can select for example: http://protege.stanford.edu/plugins/owl/owl-
library/camera.owl. Additional SemTalk datatypes are needed. The standard OWL datatypes 
can be found in the SemTalk program directory. 

Note: Instead of importing complete ontologies you can  use “Show External Model” with 
Drag&Drop (Chapter 7) and open an OWL file or URL. 

 

Load redisplay the contents of the file in the listbox 

Links selects objects related to the current selection in the listbox 

Invert inverts the selection of the listbox 

Base Class is a common superclass for all object to be imported 



��������	��
��
����

� ��������	

��
����
�������� � �58 

Namespace is the default namespace for all object to be imported 

Validate RDF with 
SemTalk Engine 

only those associations with are defined at classes are allowed 
and imported 

Document Information is meta data of the document 

Create References Each object will get a reference to the imported file so that it can 
be updated using Object->Refresh afterwards 

 

 

Exporting to OWL or RDFS is pretty simple: 

 
 

You can choose to export classes, instances, metamodel (read only classes) etc. 
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A base URN can be selected. If you assert a Base Class, only subclasses of that class will 

be exported. If you have selected some objects in your drawing, only those objects will be 

exported. 

24.3 MORE EXPORT / IMPORTS 

The following is a short summary of export import options. 

Import Picture Insert a picture such as bmp, jpg etc in the drawing. 

MS PowerPoint Export to MS PowerPoint 2003. For MS Office only the 2003 

version is supported. For Office XP and Office 2000 use 

SemTalk 1.2.5 

MS Word Export to MS Word 2003 

MS Excel Import from MS Excel 2003. Provides an MS Excel sample 

macro to create SemTalk objects via the SemTalk API. 

MS Project Export and Import to MS Project. Available for KSA (“ksa.vst”), 

EPC (“epc.vst”) and others. 

SAP Solution Composer Import Solution Maps and other diagrams from the SAP Solution 

Composer, which must be installed. Use the template “cview.vst” 

SAP Objects Import  Business Objects, Roles, KPIs and other objects from the 

SAP Solution Composer, which must be installed. 

SAP R/3 4.6c Reference 

Model 

Import processes of the SAP’s R/3 Reference model. An 

reference model database is required which can be obtained 

from SAP’s Value SAP (Asap) CD. Use the template “epc.vst” 

EPML (ARIS) Import and export of EPC models from other EPC tools such as 

ARIS via ARIS XML using the tool indepented standard EPML 

http://wi.wu-wien.ac.at/Wer_sind_wir/mendling/EPML/  Use the 

template “epc.vst” 

XTM Topic Map Import of ISO Topic Maps using the XTM format for Topic Maps 

BPEL4WS Export of the Web Services format BPEL4WS e.g. for BizTalk. 

Use the template bpmn.vst 

WSDL Import Create object definitions from XML-Schema files / WSDL. To be 

used with BPMN  
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25 USING OWL.VST 

In order to use SemTalk as an OWL editor you may open the OWL template. File->New and 

select OWL.vst.  

This tutorial does not indent to teach you how to apply OWL to the modeling of your business 

problem. Please refer to the Spec (http://www.w3.org/TR/owl-features/) or to OWL tutorials 

out on the web (http://www.cs.man.ac.uk/~horrocks/ISWC2003/Tutorial/) to learn about the 

underlying ideas of OWL. 

 

The OWL template contains additional shapes to create OWL Diagrams. An OWL diagram is 

basically a class diagram which also allows instances and some more restriction. The OWL 

stencil has some additional shapes compared to the standard SemTalk class stencil:  
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The main difference compared to standard SemTalk is, that SemTalk assumes “Closed Word 

Semantics” while OWL assumes “Open World Semantics”. “Open World Semantics” 

assumes that every two object can denote the same concept unless someone states that 

they are different. This is crucial for the global vision of Semantic Web. 

For everything ignored by SemTalk you might use a reasoner such as www.cerebra.com, 

www.ontoprise.com, FACT or RACER.  

equivalentClass Two classes actually denote the same 

concept. Ignored by the SemTalk Engine but 

exported to OWL 

disjointWith No instance is allowed to be instance of both 

classes. Ignored by SemTalk Engine but 

exported to OWL 

Instance Just an instance 

instanceOf Graphically displays that the object is 

instance of a class. An instance can be 

instance of multiple classes. Supported by 

the SemTalk Engine.  

sameIndivudualAs, sameAs Two instances denote the same object. 

Ignored by the SemTalk Engine, which 

assumes closed world semantics 

differentFrom Two instances are denoting different objects. 

Default for SemTalk 

OWL Union An abstract class describing the union of a 
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set of other classes. Use the unionOf 

relation to specify that set. Ignored by 

SemTalk Engine but exported to OWL 

unionOf Relation from a OWL Union class to other 

classes 

OWL Intersection An abstract class describing the intersection 

of a set of other classes. Use the 

intersectionOf relation to specify that set. 

Ignored by SemTalk Engine but exported to 

OWL 

intersectionOf Relation from a OWL Intersection class to 

other classes 

OWL ComplementOf An abstract class describing that instances 

of that class are not instance of another 

class. Use the complementOf relation to 

specify that other class. Ignored by SemTalk 

Engine but exported to OWL 

complementOf Relation from a OWL ComplementOf class 

to other classes 

OWL OneOf An abstract class describing that instances 

of that class are one of a set of other 

instances. Use the oneOf relation to specify 

that set. Ignored by SemTalk Engine but 

exported to OWL 

oneOf Relation from a OWL OneOf class to 

instances defining that class 

OWL AllDifferent Operator specifying that all related instances 

are different. (Default in SemTalk) 

distinctMember Member of an AllDifferent Set 

AttributeType Graphically displays an Attribute Class 

(“DataProperty” in OWL) 

RelationType Graphically displays an Association Class 

(“ObjectProperty” in OWL) 

equivalentProperty Two AttributeTypes or RelationTypes have 

same meaning. Ignored by SemTalk Engine 

but exported to OWL 
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subPropertyOf Subclassing of properties. Partially 

supported by SemTalk Engine but exported 

to OWL 

hasDomain Relation from a property to its domain. This 

can also be specified using the edit dialog 

Details tab. Supported by the SemTalk 

Engine 

hasRange Relation from a property to its range. This 

can also be specified using the edit dialog 

Details tab. Supported by the SemTalk 

Engine 

 

 

26 QUICK – REFERENCE GLOSSARY 

BPM: Acronym for Business Process Modeling. Different methodologies are used to define 

how business processes are described. 

class: A collection of things sharing a common attribute. 

CASE: Acronym for computer-aided software engineering, computer-aided systems 

engineering. Software used for the automated development of systems software, i.e. , 

computer code. CASE tools automate methods for designing, documenting, and producing 

structured computer code in the desired programming language. 

DAML: DAML (DARPA Markup Language)is a semantic markup language for Web 

resources. It builds on earlier W3C standards such as RDF and RDF Schema, and extends 

these languages with richer modelling primitives. 

inheritance: In computer object-oriented programming is the hierarchical transfer of all 

definitions and methods of a class to its subclasses.   

instance: A single item of information that is representative of a type. 

inverse name: An association points from object A to object B. The association name 

explains how to interpret this relationship. On the other hand, the inverse name of an 

association indicates the relationship from object B to object A. 
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ontology: Formal specifications of the terms in a domain and the relations among them. 

RDF: (Resource Description Framework) is a framework for metadata and provides for 

interoperability for applications in “machine-understandable” information on the Web.   

RDFS: (Resource Description Framework Schema) represents a mechanism to use RDF to 

describe RDF vocabularies. The specification defines a basic vocabulary for this purpose, as 

well as an extensibility mechanism to anticipate future additions to RDF. 

Semantic Web: An extension of the current Web in which information is given well-defined 

meaning, enabling computers and people to work in better cooperation. 

UML: Unified Modeling Language. General-purpose programming language used to develop 

complex object-oriented projects. 

URN: URNs (Uniform Resource Name) serve as persistent, location-independent, resource 

identifiers. 

WordNet: a machine-readable lexical database organized by meanings; developed at 

Princeton University 

XML: eXtensible Markup Language. It is the simplest version of the SGML (Standard 

Generalized Markup Language)  standard for creating and designing HTML documents. It is 

designed to improve the functionality of the Web by providing more flexible and adaptable 

information identification. 

 

 


